Using Microsoft Access

Forms

Although information in a database can be entered and edited directly in a table, most people find it simpler to use a form. We use forms all the time in everyday life as a way of recording information so forms are familiar to us. The Form design tools in Access are very flexible and allow you to customise a form with many features to make it easy to use. Forms can be created in a few different ways.

- Use an Auto form to create a form based on a standard layout.
- Use the Form Wizard.
- Use one of the above methods and then modify the form in Design View.
- Create a form completely from scratch using the Design View tools.

As you become more and more familiar with working with Forms in Access you may find yourself using the latter methods more and more. To begin with though, it is best to use the Auto forms and Form Wizards until you are more comfortable with designing forms.

Using Auto forms

Auto forms allow you to create a form quickly based on a standard layout. In the first exercises, you actually used an auto form when you used a form for data entry. There are several auto form layouts to choose from and we will try out three of them in the following exercises.
Exercise 1. Creating a Datasheet Auto Form

1) Make sure your Student List database is open.
2) Select the Forms section from the Database Window.
3) Click the New button at the top of the Database Window.
4) When the New Form dialog appears, click on the list at the bottom as shown below. A list of all your tables and queries appears since forms can be based on either.
5) Select your STUDENTS table from the list (it’s easy to tell which one’s a table because we named tables in uppercase and queries in lowercase).
6) From the list of options at the top of the dialog, select AutoForm: Datasheet.
7) Click OK to create the form.

The end result is a form that looks and acts the same as a table. It may not seem very useful to have a form that’s the same as a table but it can be very useful for subforms as you will see later on. Sometimes it is handy to have a list inside a form. Since a table can’t be placed inside a form, another form that looks like a table can be used instead.

8) Close the form.
9) When you are prompted to save the form, click Yes.

10) Enter STUDENTS: Datasheet as the form name and click OK.
Exercise 2. Creating a Tabular Auto form

1) Click the New button at the top of the Database Window.

2) When the New Form dialog appears, select the options shown above (STUDENTS as the table and AutoForm: Tabular as the type of form).

3) Click OK to create the form.

4) Close the form.

5) When you are prompted to save the form, click Yes.

6) Enter STUDENTS: Tabular as the form name and click OK.

A tabular form can be used in the same way as a table, but it can be formatted and customised a lot more than a table. This form could be neatened up in Design View as you will see later.
Exercise 3. Creating a Columnar Auto Form

This is the type of form that was created in the first section when you used a form for data entry.

1) Click the New button at the top of the Database Window.

![New Form dialog](image)

2) When the New Form dialog appears, select the options shown above (STUDENTS as the table and AutoForm: Tabular as the type of form).

3) Click OK to create the form.

Unlike the other two forms, this one only shows one record at a time. Most people find this makes it easier to work with records.

![STUDENTS form](image)

4) Close the form.

5) When you are prompted to save the form, click Yes.

6) Enter STUDENTS: Columnar as the form name and click OK.
**Custom Forms**
Using the Form Wizard and form Design View allow you to have a lot more control over how your form looks and functions. These methods allow you to select fields from more than one table/query as well as giving you a lot of choice about how the form will appear.

**Exercise 4. Using a Form Wizard**
1) Click the **New** button at the top of the **Database Window**.
2) Choose **Form Wizard** from the list of options. Choose **STUDENTS** for the table.

3) Click **OK** to begin the wizard.

In the first step of the wizard, you are asked to specify which fields will be used in the form.

4) Click the **>>** button to select all of the fields for use in the form. All of the fields will now be listed on the right side.
5) Double-click on **Student Number** to move it back over to the left, since we won’t need to have that displayed in our form.

6) Click **Next** to move to the next step of the wizard.
7) Leave **Columnar** selected for the Form Layout and click **Next**.

8) Click on each of the different form styles to see the preview for each one.

9) Select a style you like and click **Next**.
The last step in the wizard asks you to specify a name for the form. When you click Finish, the form is automatically saved with that name.

10) Type Student Entry Form for the form title and click Finish.

11) Close the Form. There is no need to save it since it was saved at the end of the wizard.
Reports
Reports are used in a database to present information in a neat and organised format that is ready for printing. When a report is opened in Access, it is opened in Print preview for this reason. Creating a report is very similar to creating a form and like a form, can be done using any of the following methods:

- Use an Auto report to create a form based on a standard layout.
- Use the Report Wizard.
- Use one of the above methods and then modify the report in Design View.
- Create a report completely from scratch using the Design View tools.

Exercise 5. Creating a Tabular Auto Report
1) Make sure you are in the forms section of the Database Window.
2) Click the New button at the top of the Database Window.
3) Select AutoReport: Tabular and make sure the STUDENTS table is selected as the source.
4) Click OK to create the report. The report will appear in Print Preview ready for printing.

<table>
<thead>
<tr>
<th>Number</th>
<th>Last Name</th>
<th>First Name</th>
<th>Date of Birth</th>
<th>Address</th>
<th>Suburb</th>
<th>Postc</th>
<th>State</th>
<th>Phone</th>
<th>Gender</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Robbins</td>
<td>Mark</td>
<td>17-06-89</td>
<td>4 Kensington A</td>
<td>Dianella</td>
<td>6059</td>
<td>WA</td>
<td>(66) 9375 1234</td>
<td>Male</td>
</tr>
<tr>
<td>2</td>
<td>Stevens</td>
<td>Sarah</td>
<td>10-04-89</td>
<td>24 Browns Ave</td>
<td>Yokhole</td>
<td>6060</td>
<td>WA</td>
<td>(66) 9240 8127</td>
<td>Female</td>
</tr>
<tr>
<td>3</td>
<td>Andreix</td>
<td>Claire</td>
<td>01-11-89</td>
<td>322 Water Rd</td>
<td>Morely</td>
<td>6059</td>
<td>WA</td>
<td>(66) 9275 1937</td>
<td>Female</td>
</tr>
<tr>
<td>4</td>
<td>McKay</td>
<td>Tim</td>
<td>02-06-89</td>
<td>54 Cedee St</td>
<td>Dianella</td>
<td>6059</td>
<td>WA</td>
<td>(66) 9375 5610</td>
<td>Male</td>
</tr>
</tbody>
</table>

5) Close the report. When prompted, save the report as Student Report: Tabular.
Exercise 6. Creating a Columnar Auto Report

1) Click the New button at the top of the Database Window.

2) Select AutoReport: Tabular and make sure the STUDENTS table is selected as the source.
3) Click OK to create the report. The report will appear in Print Preview ready for printing.

4) Close the report. When prompted, save the report as Student Report: Columnar.
Exercise 7. Using a Report Wizard

1) From the Database Window, click the option that says Create report by using wizard.

2) In the Tables/Queries list, make sure that table: STUDENTS is selected.

3) Click the button to select all of the fields for use in the form. All of the fields will now be listed on the right side.

4) Double-click on Student Number and Comment to move them back over to the left as shown above.

5) Click Next when ready.

6) The next step allows you to choose grouping levels for your report. Double click on Gender to select that as the grouping field. This means that all of the female students will be grouped together in the report and all the male students will be grouped together.

7) Click Next to continue.
This step in the wizard allows you to choose how the records in the report will be sorted. There are also options for adding totals and subtotals to your report.

8) In the first sort box, select Last Name as shown above. You can also select additional fields for sorting in case there are any records with the same last name.

9) Click the **Summary Options** button.

You can use these options to add totals for any number fields. The only field available here is *Mark*.

10) Click the box to put a tick under the **Avg** option as shown above. This will add an average mark figure to the report.

11) Click **OK** to return to the wizard.

12) Click **Next** to move to the next step.
13) Click **Align Left 2** for the report layout with **Landscape** selected as the orientation and click **Next**.

14) Select a report style and click **Next**.
15) Enter **Students by Gender** for the report name and click **Finish**.

**Students by Gender**

<table>
<thead>
<tr>
<th>Gender</th>
<th>Female</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last Name</td>
<td>First Name</td>
</tr>
<tr>
<td>Andrews</td>
<td>Chris</td>
</tr>
<tr>
<td>Davies</td>
<td>Lucy</td>
</tr>
<tr>
<td>Sanders</td>
<td>Emma</td>
</tr>
<tr>
<td>Shepard</td>
<td>Lissa</td>
</tr>
<tr>
<td>Springer</td>
<td>Louise</td>
</tr>
<tr>
<td>Stewart</td>
<td>Sarah</td>
</tr>
</tbody>
</table>

**Summary for Gender = Female (5 data (report))**

- Avg.

<table>
<thead>
<tr>
<th>Gender</th>
<th>Male</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last Name</td>
<td>First Name</td>
</tr>
</tbody>
</table>

**Note** The name of the report will also become the main heading on the report so choose carefully.
Report Design

Several things may appear in the Report Design window. Some may appear to begin with and others may need to be turned on before they will appear.

**Field List**
Turn on or off with the icon or with the Field List option in the View menu

Shows the fields in the table/query the report is linked to. This can be used to add more fields to the report if needed.

**Toolbox**
Turn on or off with the icon or with the Toolbox option in the View menu

This toolbar has icons for the common Report Design tools. It usually sits towards the side of the screen and can be attached to the side of the screen so it’s not in the way.

**Properties Window**
Turn on or off with the icon or with the Properties option in the View menu

This shows properties that can be modified for the report or for whichever part of the form is currently selected.

The design window itself has several sections as shown below.
Using Microsoft Access

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rulers</td>
<td>Placed along the top and side of the form to help you position and select objects on the report.</td>
</tr>
<tr>
<td>Report Header</td>
<td>The contents of this section will be displayed at the beginning of the report.</td>
</tr>
<tr>
<td>Page Header</td>
<td>This section is displayed at the top of each page in the report.</td>
</tr>
<tr>
<td>Gender Header</td>
<td>When you have used a field to group the results, this area includes everything that will appear before each group.</td>
</tr>
<tr>
<td>Detail</td>
<td>This is the section of the report that is repeated for each record.</td>
</tr>
<tr>
<td>Gender Footer</td>
<td>Summary information for each grouped field. In this case, the average for each gender will be displayed here.</td>
</tr>
<tr>
<td>Page Footer</td>
<td>Repeated at the bottom of each page. In this case, the current date and page number are displayed.</td>
</tr>
<tr>
<td>Report Footer</td>
<td>Displayed at the end of the report and usually contains totals for the report.</td>
</tr>
</tbody>
</table>

Exercise 8. Customising a Report in Report Design

1) With the Students by Gender report still open, click the View icon to go to Design View.
2) Click on the Text Box icon in the toolbox to the left of the screen.
3) Click in the Report Footer area to place the textbox as shown. A textbox will usually have a label next to it so make sure you don’t click too close to the left.

![Textbox and Label](image)

4) When you click, a textbox and a label will be created.

![Textbox and Label](image)

5) Click in the label (the one that says Text33:). Edit the label so that it says Total Students.
6) Edit the textbox (the one that says unbound) and change it so it says =count([Mark]).

This is a function that will count all of the records using the Mark field. The square brackets are used because they are necessary for any formula that refers to a field name.
7) If you are still editing the textbox, press [Enter] to exit edit mode. The whole box should be selected. Move your mouse over the top-left corner of the box. Your mouse pointer will change to a hand shape as shown.

![Hand Shape](image)

8) Use this corner to drag the textbox towards the right edge of the report. Normally dragging a textbox will move it’s related label as well. Using this corner will move only the textbox.

| Note | When moving and resizing in a report, be careful not to go too close to the edge of the report. The wizard will make the report just the right width to fit on a page. If you move things beyond the edge, even by a small amount, your report will become bigger and won’t fit on a page. The result is that when the report is printed is that you may get what appears like blank pages between every page in the report as the small overflow gets printed. |

9) Click the View icon to preview the changes to the report and see your new total.
10) Close the report and save any changes.
Exercise 9. Creating a Report from a Query

1) From the Database Window, click the option that says Create report by using wizard.

2) From the Tables/Queries list, select Query: parameter: students by suburb as shown.
3) Click the icon to select all of the fields in the query and then click Next.
4) Click Next again to skip the grouping options.

5) Choose to sort by Last name and First name as shown and click Next.
6) Leave the report layout as Tabular and click Next.
7) Select a report style and click Next.
8) For the name of the report, enter Students by Suburb and click Finish.

Because the report is based on a parameter query, the parameter criteria prompt will appear.
9) Enter Morley as the suburb and click OK to see the report.
10) Click the View icon to enter Design view.

The Report Header section contains a label with the text Students by Suburb. We will change this into a textbox that shows the name of the suburb being displayed in the report results.

11) Click the Students by Suburb label to select it.

12) From the Format menu choose Change To and then Text Box as shown to the right. When the label changes to a textbox, its contents will change to Unbound, which just means that we haven’t specified what will appear in the textbox yet.

13) In the textbox enter the following
   ="Student Listing for " & [Suburb]

This is a formula that will take the text inside the quotation marks (including the space after the word for) and then the & character will join it to the contents of the Suburb Field (since we are using the query to only show the results for one suburb.

14) Re-size the textbox to make it wider.
15) Click the view icon to preview the report.
16) Enter Morley for the suburb again. The modified report header should now include the suburb as shown below.

17) Close the report and save the changes.
18) Double-click the report to test it again with a different suburb (such as Yokine or Bedford).
19) Close the report again when you are done.